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8 Draw 
(Figures/Text)

This chapter provides a basic explanation for "Draw (Figures/Text)", and how to use the 
draw/edit tools and the other draw features in GP-Pro EX. 
Please start by reading "8.1 Settings Menu" (page 8-2), and then turn to the corresponding 
page.
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8.1 Settings Menu

Drawing Graphics

Draws a line, rectangle, and other pictures.

"8.2.1 List of Drawing Tools" 
(page 8-7)

Writing Text

Places text on the screen.

Setup Procedure (page 8-23)Production Inventory 
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Editing

Runs screen edit operations such as enlarging, reducing 
or moving.

"8.4.1 Introducing Edit Tools" 
(page 8-25)

Changing Colors, Line Types and Patterns

Changes a picture's color, line type, and pattern.

"8.5 Changing Colors, Line 
Types and Patterns" (page 8-36)

Editing a Part

Changes the shape, color, and label of a part.

"8.6.1 Editing Parts" (page 8-44)

Handle 

Handle 

Drag it to a desired position. 

Drag it to a desired size. 

Enlarging/Reducing 

Moving an Object 

Lamp 

Edit 

Start 
ON 

Stop 
OFF 



B1 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

B2 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

B3 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

Setting Input  
Screen 

Active Operations
Screen

Active Monitoring 
Screen 

B100 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

Create a screen for various 
purposes. 

You can call and display 
various screens. 

Call Screen 

Package

Drag and Drop

Objects registered in 
a package

Place it on the screen and edit it.

Settings Menu

GP-Pro EX Reference Manual 8-4

Using a Screen Multiple Times

Setup Procedure (page 8-56)

Editing a Picture on Another Screen

"8.8.1 Placing Graphics 
Registered in a Package" (page 
8-59)
"8.8.2 Registering Pictures in the 
Package" (page 8-61)

Setting up Grids

Displays an equally spaced grid on the editing screen 
and places parts with reference to an intersecting point.

Setup Procedure (page 8-63)
Introduction (page 8-63)

Menu Screen 
Setting Input 

Screen 
Active Operations 

Screen 

Active Monitoring 
Screen Alarm Screen 



Converts image data and 
places it on the screen. 

BMP, JPEG, etc. 
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Selecting a Screen from Templates

By editing screens registered as templates, you can 
reduce the number of drawing processes.

"8.9.2 Selecting a Screen from 
Templates" (page 8-66)

Pasting an Image

"  Paste Images Directly on the 
Screen" (page 8-70)
"  Registering and Using 
Images" (page 8-73)

Drawing a Detailed Picture

Draws a picture dot by dot.

Setup Procedure (page 8-75)
Introduction (page 8-75)

Select a template. 

Screen Image 3 

Template List 

Screen 
Image 1 

Screen
Image 2

Screen
Image 3

Screen
Image 4

Screen
Image 5

Screen
Image 6



Turn on the specified 
Bit...

An object that was 
hidden appears.

A value is written to 
the specified 
address...

The drawing moves 
within the specified 
range.

A value is written to 
the specified 
address...

The object rotates.

100 200

The value exceeds 
a certain value...

The color of the placed 
object changes.
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 Show/Hide of the Drawing

Setup Procedure (page 8-88)

 Change the Position of the Drawing

Setup Procedure (page 8-88)

 Rotating Drawings

Setup Procedure (page 8-88)

 Change the Color of the Drawing

Setup Procedure (page 8-88)
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8.2 Drawing Graphics

8.2.1 List of Drawing Tools

Graphic Description

Dot Draws a dot.
"8.2.2 Drawing Dots" (page 8-8)

Line/
Polyline

Draws a line/polyline.
"8.2.3 Drawing Lines/Polylines" (page 8-9)

Rectangle Draws a rectangle.
"8.2.4 Drawing Rectangles" (page 8-11)

Polygon Draws a polygon.
"8.2.7 Drawing Polygons" (page 8-17)

Circle/Oval Draws a circle/oval.
"8.2.5 Drawing Circles/Ovals" (page 8-13)

Arc/Pie Draws an arc/pie.
"8.2.6 Drawing Arcs/Pies" (page 8-15)

Scale Draws the graph scales.
"8.2.8 Drawing Scales" (page 8-19)

Table Draws a table.
"8.2.9 Drawing Tables" (page 8-21)
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8.2.2 Drawing Dots

The Dot feature can draw one to five dots at a time.
From the [Draw (D)] menu, select [Dot (D)] or click  to place a dot on the screen. 
Double-click the placed [Dot] to display the following dialog box.

For display colors, refer to"8.5.1 Setting Colors" (page 8-36)
For information about blinking, refer to"8.5.2 Setting Up Blink" (page 8-43)
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8.2.3 Drawing Lines/Polylines

Drag the mouse to draw a line from the start to the end. For the polyline, click to designate 
the start, each change of direction and the end, and right-click to set.
From the [Draw (D)] menu, select [Line (L)] or [Polyline (U)], or click  or  to place a 
line/polyline on the screen. If you double-click the placed [Line] or [Polyline], the following 
dialog box will appear.

• If you press and hold the [Shift] key while placing a line, you can draw a line 
at an angle of 0 degrees and 90 degrees.

• If you place a line while pressing the [Ctrl] key, you can draw a line 
extending from the center. If you place a line while pressing the [Ctrl] and 
[Shift] keys at the same time, you can draw a line of 0 degrees or 90 degrees 
extending from the center.

• To edit after placing the line and polyline, click on the selected line to change 
to a yellow handle. You can drag the line to change the shape.

• For a polyline, you can left click and drag to draw, similar to handwriting.

Setting Description

Line Type
Select the line type from [Solid Line], [Dotted Line], [Dash Line], [Chain 
Line], or [Two-Dot Chain Line].

"8.5.3 Setting Up Line Types" (page 8-43)

Line Thickness

Set the line thickness within the range of one to nine dots.

• When line types other than [Solid Line] are selected in [Line Type], the 
setting range is one to two dots.

Arrow Shape Select the arrow shape from , , ,  or .

Arrow Direction Select the arrow direction from [Start], [End], or [Both Ends].

Display Color Set the line color.
"8.5.1 Setting Colors" (page 8-36)

Pattern Color Select the pattern color. This function can be used only when line types 
other than [Solid Line] are selected in [Line Type].

Continued
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Blink

Select the blink and blink speed. You can choose different blink settings for 
the [Display Color] and [Pattern Color].

• There are cases where you can and cannot set Blink depending on the 
Display Unit and System Settings' [Color Settings].

"8.5.1 Setting Colors" (page 8-36)

Setting Description
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8.2.4 Drawing Rectangles

Draw a rectangle by dragging the mouse to specify two opposite corners.
In the [Draw (D)] menu, select [Rectangle (R)] or click  to place a rectangle on the 
screen. Double-click the placed [Rectangle] to display the following dialog box.

• If you press and hold the [Shift] key while drawing a rectangle, the object is 
forced into a square.

• If you place a rectangle while pressing the [Ctrl] key, you can draw a 
rectangle spreading out from the center. If you place a rectangle while 
pressing the [Ctrl] and [Shift] keys at the same time, you can draw a square 
that spreads away from the center.

Setting Description

Border

Line Type
Select the line type from [Solid Line], [Dotted Line], [Dash Line], 
[Chain Line], or [Two-Dot Chain Line].

"8.5.3 Setting Up Line Types" (page 8-43)

Line 
Thickness

Set the line thickness within the range of one to nine dots.

• When other line types than [Solid Line] are selected in [Line Type], 
the line thickness is fixed at one dot.

Display Color Set the border color.
"8.5.1 Setting Colors" (page 8-36)

Pattern Color
Select the pattern color. This function can be used only when line types 
other than [Solid Line] are selected in [Line Type].

"8.5.4 Setting Up Patterns" (page 8-43)

Blink

Select the blink and blink speed. You can choose different blink 
settings for the Part's [Display Color] and [Pattern Color].

• There are cases where you can and cannot set Blink depending on 
the Display Unit and System Settings' [Color Settings].

"8.5.1 Setting Colors" (page 8-36)
Continued
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Fill

Pattern Set a background pattern for the rectangle.
"8.5.4 Setting Up Patterns" (page 8-43)

Display Color Set a color for the rectangle.
"8.5.1 Setting Colors" (page 8-36)

Pattern Color Set the background pattern color for the rectangle.
"8.5.4 Setting Up Patterns" (page 8-43)

Blink

Select the blink and blink speed. You can choose different blink 
settings for the Part's [Display Color] and [Pattern Color].

• There are cases where you can and cannot set Blink depending on 
the Display Unit and System Settings' [Color Settings].

"8.5.1 Setting Colors" (page 8-36)

Shadow

Direction Select the shadow direction from [Top Left], [Bottom Left], [Top 
Right], or [Bottom Right].

Color Set a color for the shadow.
"8.5.1 Setting Colors" (page 8-36)

Shadow Width Set the width of the picture and the shadow within the range of 1 to 16.
Chamfer Select the chamfer shape from [None], [Line], or [Circle].

Number of Pixels

Designate the number of pixels for chamfer from 1 to 999.

Setting Description

Set the number of dots in this space. 



Drawing Graphics

GP-Pro EX Reference Manual 8-13

8.2.5 Drawing Circles/Ovals

Draw a circle or oval by dragging the mouse to specify the center point and one point on the 
circle.
From the [Draw (D)] menu, select [Circle/Oval (C)] or click  to place a circle/oval on the 
screen. Double-click the placed [Circle/Oval] to display the following dialog box.

  

• If you press and hold the [Shift] key while placing an object, you can draw a 
circle. 

• If you place a circle/oval while pressing the [Ctrl] key, you can draw a circle/
oval spreading out from the center.If you place a circle/oval while pressing 
the [Ctrl] and [Shift] keys at the same time, you can draw a circle spreading 
out from the center.

Setting Description

Border

Line Type
Select the line type from [Solid Line], [Dotted Line], [Dash Line], 
[Chain Line], or [Two-Dot Chain Line].

"8.5.3 Setting Up Line Types" (page 8-43)

Line 
Thickness

Set the line thickness within the range of one to nine dots.

• When other line types than [Solid Line] are selected in [Line Type], 
the line thickness is fixed at one dot.

Display Color Set the border color.
"8.5.1 Setting Colors" (page 8-36)

Pattern Color
Select the pattern color. This function can be used only when line types 
other than [Solid Line] are selected in [Line Type].

"8.5.4 Setting Up Patterns" (page 8-43)
Continued
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Border Blink

Select the blink and blink speed. You can choose different blink 
settings for the Part's [Display Color] and [Pattern Color].

• There are cases where you can and cannot set Blink depending on 
the Display Unit and System Settings' [Color Settings].

"8.5.1 Setting Colors" (page 8-36)

Fill

Pattern Set the background pattern for the circle/oval.
"8.5.4 Setting Up Patterns" (page 8-43)

Display Color Set a color for the circle/oval.
"8.5.1 Setting Colors" (page 8-36)

Pattern Color Set the background pattern color for the circle/oval.
"8.5.4 Setting Up Patterns" (page 8-43)

Blink

Select the blink and blink speed. You can choose different blink 
settings for the Part's [Display Color] and [Pattern Color].

• There are cases where you can and cannot set Blink depending on 
the Display Unit and System Settings' [Color Settings].

"8.5.1 Setting Colors" (page 8-36)

Shadow

Direction Select the shadow direction from [Top Left], [Bottom Left], [Top 
Right], or [Bottom Right].

Color Set a color for the shadow.
"8.5.1 Setting Colors" (page 8-36)

Shadow Width Set the width of the circle/oval and the shadow within the range of 1 to 
16.

• You can set the width and height of a circle/oval in [Properties (P)]. 
However, if you set the width or height to an even number, it will be drawn 
with one less dot on the GP.

Setting Description

Height, width 100 dots 

In GP-Pro EX 

(99,99) 

(0,0) 

Height, width 99 dots 

On the GP 

(99,98) 

(0,0) 
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8.2.6 Drawing Arcs/Pies

Draw an arc or pie by dragging the mouse to specify the center point and one point on the 
circle, and specify the start angle and end angle in the dialog box. You can select an arc or 
pie.
From the [Draw (D)] menu, select [Arc/Pie (A)] or click  to place an arc/pie on the 
screen. Double-click the placed [Arc/Pie] to display the following dialog box.

• If you press and hold the [Shift] key while placing an object, you can draw a 
circle arc.

• If you place an arc/pie while pressing the [Ctrl] key, you can draw a circle/
oval's arc spreading out from the center. If you place an arc/pie while 
pressing the [Ctrl] and [Shift] keys at the same time, you can draw a circle's 
arc spreading out from the center.

• If you edit an arc/pie after placing it, you can change the arc/pie's start angle 
and end angle by operating the yellow handle in the selected state.

• You can set the width and height of an arc//pie in [Properties (P)]. However, 
if you set the width or height to an even number, it will be drawn with one 
less dot on the GP.

Setting Description

Line Type Select the line type from [Solid Line], [Dotted Line], [Dash Line], 
[Chain Line], or [Two-Dot Chain Line].

Border Line 
Thickness

Set the line thickness within the range of one to nine dots.

• When other line types than [Solid Line] are selected in [Line Type], 
the line thickness is fixed at one dot.

Display Color Set the arc/pie border color.

Pattern Color Select the pattern color. This function can be used only when line types 
other than [Solid Line] are selected in [Line Type].

Continued
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Border Blink

Select the blink and blink speed. You can choose different blink 
settings for the Part's [Display Color] and [Pattern Color].

• There are cases where you can and cannot set Blink depending on 
the Display Unit and System Settings' [Color Settings].

"8.5.1 Setting Colors" (page 8-36)

Fill

Pattern Select a background pattern for the pie.
Display Color Set the pie's color.
Pattern Color Set the background pattern color for the pie.

Blink

Select the blink and blink speed. You can choose different blink 
settings for the Part's [Display Color] and [Pattern Color].

• There are cases where you can and cannot set Blink depending on 
the Display Unit and System Settings' [Color Settings].

"8.5.1 Setting Colors" (page 8-36)

Shadow
Direction Select the shadow direction from [Top Left], [Bottom Left], [Top 

Right], or [Bottom Right].
Color Set a color for the shadow.
Shadow Width Set the width of the arc/pie and its shadow within the range of 1 to 16.

Arc/Pie Select from [Arc] or [Pie].

Start Angle/End Angle

Set the [Start Angle] or [End Angle].

• When the same value is defined for the start and end angles, a dot 
indicates the start point, and a line extends from the center of the pie 
to the start point.

Setting Description
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8.2.7 Drawing Polygons

To draw a polygon, click each apex and right-click to define a polygon.
From the [Draw (D)] menu, select [Polygon (P)] or click  to place a polygon on the 
screen. Double-click the placed [Polygon] to display the following dialog box.

• To edit a polygon, click on a line in the polygon to change to a yellow handle. 
You can drag a line on the polygon to change the shape.

Setting Description

Border

Line Type
Select the line type from [Solid Line], [Dotted Line], [Dash Line], 
[Chain Line], or [Two-Dot Chain Line].

"8.5.3 Setting Up Line Types" (page 8-43)

Line 
Thickness

Set the line thickness within the range of one to nine dots.

• When other line types than [Solid Line] are selected in [Line Type], 
the line thickness is fixed at one dot.

Display Color Set the border color.
"8.5.1 Setting Colors" (page 8-36)

Pattern Color
Select the pattern color. This function can be used only when line types 
other than [Solid Line] are selected in [Line Type].

"8.5.4 Setting Up Patterns" (page 8-43)

Blink

Select the blink and blink speed. You can choose different blink 
settings for the Part's [Display Color] and [Pattern Color].

• There are cases where you can and cannot set Blink depending on 
the Display Unit and System Settings' [Color Settings].

"8.5.1 Setting Colors" (page 8-36)
Continued
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Fill

Pattern Set a background pattern for the polygon.
"8.5.4 Setting Up Patterns" (page 8-43)

Display Color Set a color for the polygon.
"8.5.1 Setting Colors" (page 8-36)

Pattern Color Set a background pattern's color for the polygon.
"8.5.4 Setting Up Patterns" (page 8-43)

Blink

Select the blink and blink speed. You can choose different blink 
settings for the Part's [Display Color] and [Pattern Color].

• There are cases where you can and cannot set Blink depending on 
the Display Unit and System Settings' [Color Settings].

"8.5.1 Setting Colors" (page 8-36)

Shadow

Direction Select the shadow direction from [Top Left], [Bottom Left], [Top 
Right], or [Bottom Right].

Color Set a color for the shadow.
"8.5.1 Setting Colors" (page 8-36)

Shadow Width Set the width of the polygon and its shadow within the range of 1 to 
16.

Setting Description
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8.2.8 Drawing Scales

Draw a scale by dragging to specify two opposite corners. Set the divisions of the scale in the 
following dialog box.
From the [Draw (D)] menu, select [Scales (M)] or click  to place a scale on the screen. 
Double-click the placed [Scale] to display the following dialog box.

• To edit a scale after placing it, click the line in the selected state to make it a 
yellow handle. You can change the scale type by operating the yellow handle 
axis.

Setting Description

Scale

Line Type
Select the line type from [Solid Line], [Dotted Line], [Dash Line], 
[Chain Line], or [Two-Dot Chain Line].

"8.5.3 Setting Up Line Types" (page 8-43)

Line 
Thickness

Set the line thickness within the range of one to nine dots.

• When line types other than [Solid Line] are selected in [Line Type], 
the setting range is one to two dots.

Display Color Select the scale color.
"8.5.1 Setting Colors" (page 8-36)

Pattern Color
Select the pattern color. This function can be used only when line types 
other than [Solid Line] are selected in [Line Type].

"8.5.4 Setting Up Patterns" (page 8-43)
Continued
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Scale Blink

Select the blink and blink speed. You can choose different blink 
settings for the Part's [Display Color] and [Pattern Color].

• There are cases where you can and cannot set Blink depending on 
the Display Unit and System Settings' [Color Settings].

"8.5.1 Setting Colors" (page 8-36)

Major 
Scale

Divisions

Select from 1 to 999 large-scale axis divisions.

Length Select the large scale length from 2 to 3,072.

Minor 
Scale

Divisions

Select from 2 to 999 minor-scale axis divisions.

Length Select the minor scale length from 1 to 3,071.
Draw 
Axis Axis Position Select the scale direction from the axis from [Left] or [Right]. 

Continued

Type

Bar (Vertical) Displays the scale for a vertical bar graph.
Bar 
(Horizontal) Displays the scale for a horizontal bar graph.

Arc

Displays the scale for a circle graph.

• You can set the width and height of a scale in the [Properties (P)]. 
However, if you set the width or height to an even number, it will be 
drawn with one less dot on the GP.

Start Angle/End Angle

Set the [Start Angle] or [End Angle].

• When the same value is defined for the start and end angles, the scale 
becomes a circle. 

Setting Description

Large Scale 

Minor Scale 
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8.2.9 Drawing Tables

Draw a table by dragging to specify two opposite corners. Set the rungs and number of 
columns in the following dialog box.
From the [Draw (D)] menu, select [Table (T)] or click  to place a table on the screen, and 
set the number of rows and number of columns in the following dialog box displayed by a 
double-click.

  

• To edit the table after placing it, click a line of the table in the selected state 
to make it a yellow handle. You can change the inside border spacing by 
operating the yellow handle.

•  When you click this icon, drag to select the table frame borders and 
move the pointer  to the drawing area to place the defined table.

Setting Description

Show 
Border

Line Type
Select the line type from [Solid Line], [Dotted Line], [Dash Line], 
[Chain Line], or [Two-Dot Chain Line].

"8.5.3 Setting Up Line Types" (page 8-43)

Line 
Thickness

Set the line thickness within the range of one to nine dots.

• When line types other than [Solid Line] are selected in [Line Type], 
the line thickness is fixed to one dot.

Display Color Set the outer border color for the table.
"8.5.1 Setting Colors" (page 8-36)

Pattern Color Select the pattern color.This function can be used only when line types 
other than [Solid Line] are selected in [Line Type].

Continued
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Show 
Border Blink

Select the blink and blink speed. You can choose different blink settings 
for the Part's [Display Color] and [Pattern Color].

• There are cases where you can and cannot set Blink depending on the 
Display Unit and System Settings' [Color Settings].

"8.5.1 Setting Colors" (page 8-36)

Inside 
Border

Line Type
Select the line type from [Solid Line], [Dotted Line], [Dash Line], 
[Chain Line], or [Two-Dot Chain Line].

"8.5.3 Setting Up Line Types" (page 8-43)

Line 
Thickness

Set the line thickness within the range of one to nine dots.

• When other line types than [Solid Line] are selected in [Line Type], 
the line thickness is fixed at one dot.

Display Color Set the inside border color for the table.
"8.5.1 Setting Colors" (page 8-36)

Pattern Color
Select the pattern color. This function can be used only when line types 
other than [Solid Line] are selected in [Line Type].

"8.5.4 Setting Up Patterns" (page 8-43)

Blink

Select the blink and blink speed. You can choose different blink settings 
for the Part's [Display Color] and [Pattern Color].

• There are cases where you can and cannot set Blink depending on the 
Display Unit and System Settings' [Color Settings].

"8.5.1 Setting Colors" (page 8-36)

Fill

Pattern Select a background pattern for the table.
"8.5.4 Setting Up Patterns" (page 8-43)

Display Color Set the table color.
"8.5.1 Setting Colors" (page 8-36)

Pattern Color Set the background pattern color for the table.
"8.5.4 Setting Up Patterns" (page 8-43)

Blink

Select the blink and blink speed. You can choose different blink settings 
for the Part's [Display Color] and [Pattern Color].

• There are cases where you can and cannot set Blink depending on the 
Display Unit and System Settings' [Color Settings].

"8.5.1 Setting Colors" (page 8-36)

Interval

Select from [Equal Spacing] or [Free].
• Equal Spacing

The row width and column width are made equal.
• Free

The row width and column width can be adjusted freely.

Divisions Designate the number of rows [Vertical] and number of columns 
[Horizontal] in the table from 1 to 30.

Setting Description
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8.3 Writing Text

Draw text on the drawing screen.
To draw text that changes depending on the selected display language on the GP, use the text 
table. For settings, refer to "17.4 Changing a Text's Language (Multilanguage)" (page 17-15).

8.3.1 Setup Procedure

To place the text "Production Inventory" on the drawing screen.

1 From the [Draw (D)] menu, select [Text (S)] or click  to place text on the screen.

• Please refer to the Settings Guide for details.
"8.13.1 Text Settings Guide" (page 8-91)

Production Inventory 
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2 Click the placed text. When the text border appears, drag to adjust its size and position.

3 Double-click the placed text and the [Text] dialog box will appear.
Designate the font and size and input text to place in the Input Text border.(For example, 
Production Inventory)

4 Click [OK] and the input text "Production Inventory" will be placed.
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8.4 Editing

8.4.1 Introducing Edit Tools

Setting Description

Cut

Cut the object (Parts, Text, Figure). Use [Paste (P)] to place the 
object back on the screen.

Operating Procedure
You can cut an object by selecting a desired object and click 
[Cut] in the [Edit] menu.

Copy 

Copies the selected object. Place it on the screen by using the 
[Paste].

Operating Procedure
You can copy by selecting a desired object and click [Copy] in 
the [Edit] menu.

Paste

Pastes the copied or cut object onto a screen.

Operating Procedure
You can paste the object you copied or cut by clicking [Paste] 
in the [Edit] menu.

• When pasting from one screen to another, you can paste the 
object to the same position as the other screen.

Duplicate

Copies multiple pictures at a time. When duplicating parts, you 
can automatically assign the next consecutive address after the 
source part's address to the destination part.

"8.4.5 Duplicate" (page 8-28)

Delete
Deletes an object.

Operating Procedure
You can delete by selecting the desired object and clicking 
[Delete (D)] in the [Edit] menu.

Select All
Selects all the objects on the screen.
You can also specify the range to drag multiple objects.

"8.4.2 Selection Method" (page 8-26)

Edit 
Vertex

You can edit, delete or insert each vertex coordinate of a polyline 
or polygon.

"  Edit Vertex" (page 8-30)

Group
You can group multiple objects together and treat them as one 
unit.

"8.4.7 Grouping (Ungrouping)" (page 8-31)

Order
When the placed objects are overlapping, you can change the 
placement order.

"8.4.8 Order" (page 8-33)
Continued
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8.4.2 Selection Method

There are two ways to select an object: click the object directly or specify the range to drag 
multiple surrounding objects.

Place/ 
Align

Using Align Right, Align Left, Align Center, and so on, you can 
adjust the positions of multiple objects.

"8.4.9 Aligning" (page 8-33)

Rotate/
Flip

• Rotate
Rotates the object by 90 degrees.

"8.4.10 Rotating Right or Left" (page 8-34)
• Flip

Flips the object horizontally or vertically.
"8.4.11 Reversing X-Axis (Vertical)/Y-Axis (Horizontal)" (page 8-34)

Others Sets a grid and guidelines to align a part with another one.
"8.9 Creating a Screen from a Template" (page 8-63)

• To select one of the overlapping objects, click the object while pressing the 
[Ctrl] key. Each object becomes in the selective state in turn, and you can 
select the target object.

• To release a particular object from the selected objects, click the target object while 
pressing the [Shift] key.

• To add a particular object to the selected objects, click the target object while 
pressing the [Shift] key.

Setting Description
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8.4.3 Enlarging and Reducing the Size

Select the target object and hover the cursor on the handle. When the cursor turns to , you 
can zoom in or out and drag the object to the appropriate size.

8.4.4 Moving Objects

Select the target object and hover the cursor on the object. When the cursor turns to , you 
can drag the object to the appropriate location.

• If you select an object and move the four-cornered handles while pressing the 
[Shift] key, you can enlarge/reduce it with the same horizontal to vertical 
ratio.

• With the cursor on an object handle, you can use the [↑], [→], [←], and [↓] 
keys to increase or decrease the object's size by one dot.

• If you move while pressing the [Shift] key, you can move the object 
horizontally or vertically.

• If you use the [↑], [→], [←], and [↓] keys with the object selected, you can 
move the object a dot at a time.

Handle 

Drag it to a desired size. 

Handle 

Drag it to a desired position. 
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8.4.5 Duplicate

Copies multiple pictures at a time.
Right-click the object and click [Duplicate (W)]. [Duplicate] dialog box appears. Set the 
number of copies and copy direction.

• You can automatically assign the next consecutive address after the source 
part's address to the destination part.

Setting Description

Specify Range

Select how to specify the area from [Disable], [Set Up Using the Mouse] and 
[Set Up Interval].
• Disable

Make copies without spacing.
• Set Using the Mouse

Using the defined interval, makes copies that fit into the range.
• Setting Intervals

Set the number of pixels between objects, from 1 to 99.

X Direction
Set the number of display positions in the X direction from 1 to 99.
• Interval

Set the number of pixels between objects, from 1 to 99.
Continued
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Y Direction
Set the number of display positions in the Y direction from 1 to 99.
• Interval

Set the number of pixels between objects, from 1 to 99.

Copy Direction

Select the display direction from , , , , , ,  or .

• When you add addresses, sequential addresses are assigned in the specified 
direction according to the address addition width.

Duplicate 
Comment

The copy source comment is reflected in the copy destination.

Automatically 
Increment 
Addresses

You can assign sequential addresses from the copy-from addresses according 
to the [Increment Each Address by].
• Enable

Designates an address interval. When the copy-from addresses are Bit 
addresses, addresses are added by the Bit. When the copy-from addresses 
are Word addresses, addresses are added by the Word.

• Disable
Addresses are not assigned automatically.

Setting Description
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8.4.6 Changing Attributes

You can change object attributes such as color or address.
To change attributes, double-click the object while selecting it or select [Change Attributes 
(M)] from the [Edit] menu.

Edit Vertex
You can edit, delete, or insert each vertex coordinate of a polyline or polygon.
To edit the object's vertex, click a line in the selected state to change it to a yellow handle. 
Change the shape of the object by clicking an arbitrary line. To delete the vertex, right-click 
on the vertex and select [Delete Vertex].

• When multiple objects are selected, you cannot change attributes.
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8.4.7 Grouping (Ungrouping)

You can group multiple objects and handle them as one object. To do so, select multiple 
objects, right-click, and click [Group (E)]. To ungroup, click [Ungroup (U)].

• When Animation is set for a group, Animation Settings will be reflected in 
all the parts belonging to the group. However, Animation that can be set is 
limited to Animation supported by all parts belonging to the group.

"Chapter 20 Animating Screen Objects", page 20-1
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Batch Conversion of Parts and Objects
Select multiple objects or parts of the same type and use the [Properties (P)] window to 
change attributes of the selected objects in one step.

• When you select grouped objects, only parts information and coordinates are 
displayed.

• When you select multiple types of parts, you can change coordinates only.
• When multiple switch operations are added to a single switch (Multi-

function feature), you cannot change the [Switch Feature].
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8.4.8 Order

When the placed objects are overlapping, you can change the placement order. Select and 
right-click the object whose order you want to change, click [Order (O)], and select the object 
order from [Bring to Front], [Send to Back], [Move Forward], or [Move Backward]. In the 
following example, the oval is moved backward.

8.4.9 Aligning

You can align the position of multiple objects. Select the objects that you want to align, right-
click, and then select [Align Left (L)], [Right (R)], [Top (T)], [Bottom (B)], [Align Center 
(Horizontal) (C)], [Align Center (Vertical) (M)], or [Others (E)] from [Place/Align (A)]. In 
the following example, the rectangle, polygon, and circle are all aligned to the top.
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8.4.10 Rotating Right or Left

You can rotate the object to the right and left 90 degrees at a time. Right click to select the 
object you want to rotate, select [Rotate Right (E)] or [Rotate Left (I)] in [Rotate/Flip]. The 
following example describes placement of a right-rotated polygon.

8.4.11 Reversing X-Axis (Vertical)/Y-Axis (Horizontal)

From the object's center, you can flip objects vertically (X-axis) or horizontally (Y-axis). 
Select the object to flip, and from the right-click menu point to [Rotate/Flip (R)] and click 
[Flip Horizontal (H)] or [Flip Vertical (V)]. The following example shows a polygon flipped 
horizontally. Please note that when you flip screens, marks, parts, and text that are called into 
the screen, only the display position is reflected.
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8.4.12 Changing Coordinates

You can change the position and size of an object by designating a coordinate in the 
[Properties (P)]. The reference of the coordinate is the top left of an object.

8.4.13 Protecting Objects That You Do Not Want to Edit

Fixing Objects
Place drawings and parts, and a blue fixed pin  appears at the top-left corner of the object 
on the screen. If you click the pin, it turns red  and the object cannot be selected or edited. 
When you put the cursor over the object, a "lock" mark appears to the right, indicating that 
the placement position is fixed.

Releasing Fixed Pins
• Releasing individual objects

Double-click a drawing or part, click  and the pin turns blue.
• Releasing all fixed pins on the screen

From the [Edit (E)] menu, select [Release All Fixed Pins (K)].

• If the [Properties] tab is not displayed in either the work space or the screen 
drawing area, from the [View (V)] menu, point to [Work Space (W)] and 
select [Properties Window (P)].

• Click the pin marks in the list of drawings and parts displayed in the [Screen 
Data List] window, and the fixed pins can be set/released.

Click the blue fixed pin The fixed pin turns red to 
indicate the part is locked
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8.5 Changing Colors, Line Types and Patterns

8.5.1 Setting Colors

List of Compatible Colors

Model Display Device Display Color
Number of 
Colors in 
Drawing

AGP-3200T TFT Color LCD 256 Colors, No Blink
64 Colors, 3-Speed Blink

256 Colors
64 Colors

AGP-3200A Monochrome LCD 8 Levels, 1-Speed Blink Monochrome 8 
Levels

AGP-3302B Blue-mode Monochrome 
LCD 16 Levels, 3-Speed Blink 16 Levels

AGP-3301L Monochrome LCD Monochrome 16 Levels 3-
Speed Blink

Monochrome 16 
Levels

AGP-3301S STN Color LCD 4096 Colors, 3-Speed Blink 256 Colors

AGP-3300L Monochrome LCD Monochrome 16 Levels 3-
Speed Blink

Monochrome 16 
Levels

AGP-3300S STN Color LCD 4096 Colors, 3-Speed Blink 256 Colors

AGP-3300T TFT Color LCD 65536 Colors, No Blink
16384 Colors, 3-Speed Blink 256 Colors

AGP3300HL Monochrome LCD 4096 Colors, No Blink 256 Colors

AGP3300HS STN Color LCD 16 Levels of Monochrome 
Shading, No Blink

Monochrome 16 
Levels

AGP3310HT TFT Color LCD 65536 Colors, No Blink 256 Colors
AGP-3400S STN Color LCD 4096 Colors, 3-Speed Blink 256 Colors

AGP-3400T TFT Color LCD 65536 Colors, No Blink
16384 Colors, 3-Speed Blink 256 Colors

AGP-3500T TFT Color LCD 65536 Colors, No Blink
16384 Colors, 3-Speed Blink 256 Colors

AGP-3500L Monochrome LCD Monochrome 16 Levels 3-
Speed Blink

Monochrome 16 
Levels

AGP-3500S STN Color LCD 4096 Colors, 3-Speed Blink 256 Colors
Continued
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AGP-3510T

TFT Color LCD 65536 Colors, No Blink
16384 Colors, 3-Speed Blink 256 Colors

AGP-3560T
AGP-3600T
AGP-3450T
AGP-3550T
AGP-3650T
AGP-3750T
AST-3201A Monochrome LCD 

(Amber) 8 Levels, 1 Speed Blink Monochrome 8 
LevelsAST-3211A

AST-3301B Blue-mode Monochrome 
LCD 8 Levels, 1 Speed Blink Monochrome 8 

Levels

AST-3301S STN Color LCD 256 Colors, No Blink
64 Colors, 3-Speed Blink

256 Colors
64 Colors

AST-3401T TFT Color LCD 256 Colors, No Blink
64 Colors, 3-Speed Blink

256 Colors
64 Colors

AST-3501C LCD Color 16 Colors, 1-Speed Blink 16 Colors

AST-3501T TFT Color LCD 256 Colors, No Blink
64 Colors, 3-Speed Blink

256 Colors
64 Colors

LT-3201A Monochrome LCD 
(Umber) 8 Levels, No Blink Monochrome 8 

Levels
LT-3300S STN Color LCD 4096 Colors, 3-Speed Blink 256 Colors
LT-3301L

Monochrome LCD Monochrome 16 Levels 3-
Speed Blink

Monochrome 16 
LevelsLT-3300L

PS-3,651A

TFT Color LCD 65536 Colors, No Blink
16384 Colors, 3-Speed Blink 256 Colors

PS-3,650A
PS-3,700A
PS-3,451A
PS-3,450A
PS-3711A
PS-3710A
PS-2000B
PL-3000B

• Objects set up with the blink option will blink ON and OFF on the display unit. 
You can define three different blinking speeds.

"8.5.2 Setting Up Blink" (page 8-43)
• On monochrome LCD models and STN Color LCD models, when you set a 

tiling pattern in the background settings to use the blink setting, some drawing 
components that do not have the blink setting may blink. Please confirm the 
display in advance.
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Specifying Colors
Set the object colors. Depending on part type, setting items such as colors of a border, fill, 
shadow or label, differ depending on the part type.

For a 256-color supported model For a monochrome 16-level supported model

• For a 256-color compatible model, change the palette with the color code 
order button under the color palette, and colors can be selected with the color 
code number.

• You can only select [Transparent] for the [Pattern Color] for a Switch Lamp 
that does not use the [Lamp Feature] or for a Key that has a [Pattern] set in 
the settings dialog box.

• When you change from a model that supports more than 16 colors to a model 
that supports only 16 colors, colors inside the 16 color range remain as is. 
Colors outside the 16 color range are converted to one of the 16 colors.

• When using AGP-3200T or ST3000 Series, some specified colors may 
appear more bluish than in the drawing software.

• For a monochrome 16-level model, there are some cases where color 
distinction is difficult or where flicker is caused. Use the color designation 
above after confirming the colors.



Changing Colors, Line Types and Patterns

GP-Pro EX Reference Manual 8-39

Color Palette
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Changing Colors with Drag and Drop
You can change colors by dragging and dropping colors from [Color Settings (O)] workspace 
to the object on the editor screen.

1 Drag the selected color to the object on the drawing screen, and when the [Feature List] 
window appears drop the color onto [Display Color]. 

2 The display colors of the object will change to the dropped color.

• When the [Color] window is not displayed, from the [View (V)] menu,  
point to [Work Space (W)] and select [Color Settings (O)].

• In the [Color] window you can set up blinking.
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Types of Palettes
The type of palette will vary depending on the model and settings.

Models That Support Color
You can select between [Color] and [Monochrome] palettes.
When [Color] is selected, select the display order of color cells by color code or hue.
When [Monochrome] is selected, a 12 level monochrome palette displays. The 4 missing 
colors of the 16 level monochrome are included in the [Color] palette.

Color (Color Code Order) Color (Hue Order)

Monochrome (12 Levels)
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Models That Support Monochrome
You cannot select [Color] as the color palette. A 16 level monochrome palette displays.

Non-Blinking Palettes
In the [Display Unit] page, when blink is disabled in the [Display Settings] area, the blink 
options will not display.

5.17.6 [System Settings] Setting Guide   [Display Unit] Settings Guide   Display Set-
tings 5-147

When Blink is ON When Blink is OFF

For information about blinking, refer to"8.5.2 Setting Up Blink" (page 8-43)
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8.5.2 Setting Up Blink

Blink makes the object blink on the display and has three selectable blink speed rates (Slow, 
Medium, Fast). [Fast] is twice the speed of [Medium] and [Slow] is half the speed of 
[Medium].
If you select [None], the object will not blink.

8.5.3 Setting Up Line Types

You can select the line type from five types: [Solid Line], [Dotted Line], [Dash Line], [Chain 
Line], or [Two-Dot Chain Line].

8.5.4 Setting Up Patterns

Select a pattern from the following nine types.

• For faded color blink refer to 5.17.6 [System Settings] Setting Guide   
[Display Unit] Settings Guide   Display Settings 5-147.
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8.6 Editing a Part

8.6.1 Editing Parts

1 From the [Parts (P)] menu, point to [Switch Lamp (C)] and select [Lamp (L)] or click .

2  Move the pointer to the drawing screen and the pointer changes to a cross-hair cursor 
.

3 Drag the switch to the desired location. Release to place the switch.

• You can also drag and drop a part from the Parts Toolbox. 
From the [View (V)] menu, point to [Work Space (W)] and then click [Parts 
Toolbox (T)]. In the Parts Toolbox, select the [Parts Palette] and [Type] to 
browse various parts and shapes.

"5.17.5 [Work Space] Settings Guide  Parts Toolbox" (page 5-142)

Lamp 

Edit 

Start 
ON 

Stop 
OFF 
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4 Double-click the placed lamp. The Switch/Lamp dialog box appears.

5 Click the  icon to display the [Input Address] dialog box.
 Click the icon and select the [Device/PLC] and [Device]. Input an address from the 

keypad. 
(For example, M100)

6 Click [Select Shape].

• Input the address with the keypad on the Input Address dialog. If you input it 
directly with the PC keyboard, it may not be recognized as an address.

• Select the [Use as Default Value] check box and click [Ent], and the value 
registered as the default value in the [Address Input] dialog box will appear 
on the next time.
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7 The [Select State Window] appears. Select [State 0] and click [Open].

8 Select [Standard Parts] from the [Part Palette]. Next select the picture with [Part Number] 
"SW_3D202_OFF".

9 Click [OK] and the display returns to the [Select State Window]. Select [State 1] and click 
[Open].

• Use the Parts Palette drop-down list to change the images displayed. There 
are parts with 65536, 256, or 64 colors. Please select the part palette that 
matches the colors supported by your model.
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10 Select [Standard Parts] from the [Part Palette]. Next, select the picture with [Part Number] 
"SW_3D202_ON".

11 The pictures at [State 0] (OFF) and [State 1] (ON) are displayed. Click [OK].

• Click [Auto] after defining the picture in [State 0] to automatically match the 
pictures for all other states with [State 0].

• If different states have different shapes, part of a previous shape may remain 
in the background when touching the switch to change its state. This results 
because part shapes are drawn by overwriting the other.
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12 Click the [Color] tab. Confirm that [Select State] is OFF and set the color of the switch for 
the OFF state. For the [Display Color], click  and select a color from the color palette.

13 Click  in [Select State] to select ON, and set the color of the switch for the ON state.

• You cannot edit the color for the Switch/Lamp menu image parts.
• To change the palette in the color code order, click the color code button 

under the palette.

• You cannot edit the color for the Switch/Lamp menu image parts.
• To change the palette in the color code order, click the color code button 

under the palette.
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14 Select the [Label] tab. Click  in [Select State] to select OFF, and input the text to be 
displayed on the switch in the OFF state. (For example, START)

15 Click  in [Select State] to select ON and input the text to be displayed on the switch in the 
ON state. (For example, STOP)

16 Click [OK] when all the settings are complete.

• Select the switch and press [F2] key, and you can directly edit the text on the 
label.
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8.6.2 Creating Your Own Parts

Register new images for parts.

1 Double-click the part for which you want to register a new image, and the following dialog 
box will appear. Click [Select Shape], (For example, switch)

2 The [Shape Browser] dialog box will appear. Click [New Palette].
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3 The [Save As] dialog box will appear. Define the [Location (I)] and [File Name (N)] of the 
new part palette you and click [Save (S)].

4 When the following message appears, click [Yes (Y)].

5 The newly registered [Shape Browser] dialog box will appear. Click [Create].
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6 The [Register Part] dialog box will appear. Select [State 0], and click [Select].

7 When the [Open File] dialog box appears, navigate to the image location [Look In], select the 
file [File Name] and [Look in] and [File name] and click [Open].
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8 The image will be registered in the [Register Part] dialog box [State 0].

9 If necessary, set the part number and number of colors for the image to register in [Title] and 
[Color Settings], and click [Register], to complete the process.

• You can use the [Parts Toolbox] ON/OFF options to view Switches, Lamps, 
and Key parts in [State 0] (OFF) and [State 1] (ON).

• To select the registered image for the part, open the Parts dialog box 
and click [Select Shape]. In the [Shape Browser] dialog box, from the [Parts 
Palette] list select a palette to display its registered images. Select the 
appropriate image and click [OK].

• If you click "Create" while a previously registered part is selected, you can 
edit that part image. To create a new image, click the "Create" button while 
no previously registered part is selected.

• Image parts can be registered with a maximum size of 160 x 160 dots.
• Parts which use registered images can cause large project file sizes. It is 

recommended you set [Compress] in the [Color].
• You can register up to 200 image parts in a single parts palette file.
• Image parts that have been enlarged or reduced may display differently on 

the GP and in Pro-EX.
• When the registered image size is different depending on the state, the larger 

image will remain the same, and the smaller image will be enlarged.
• You cannot register or delete a previously-prepared PDX file.
• The types of image file that can be registered to a part are BMP, JPEG, DPD, 

and PNG.
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8.6.3 Registering Frequently Used Parts as Your Favorites

You can register frequently used parts in the [Package] window's [Favorites] list.
You can also combine multiple objects together for registration.

1 Open the [Package] window and select the [Favorite] package.

2 Select the figure to register, and drag it to the [Package] window.

• To display the [Package] window, on the [View (V)] menu, point to [Work 
Space (W)] and then click [Package (K)].

• After the application is just installed, opening the [Package] window displays 
the [Favorite] package. The next time the application is started, the [Package] 
window displays the last-used package.
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3 Package registration is complete.

• To register the figure to a separate package, in the [Package List] dialog box, 
select New and create a new package.
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8.7 Using a Screen Multiple Times

8.7.1 Setup Procedure

1 From the [Screen (S)] menu, select [New Screen (N)]. The following [New Screen] dialog 
box will appear. Click [New] to create a new base screen. (For example, Base Screen 2)

2 From the [Draw (D)] menu, select [Call Screen (O)] or click .

B1 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

B2 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

B3 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

Setting Input  
Screen 

Active Operations
Screen

Active Monitoring 
Screen 

B100 

Setting Input Screen Active Operations Screen Active Monitoring Screen Alarm Screen 

Create a screen for various 
purposes. 

You can call and display 
various screens. 

Call Screen 
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3 When drag onto the created screen, a dashed line displays and the [Call Screen] dialog box 
appears.

4 Select the target image from [Call Target].

Base Screen Previously created base screens will display.
Image (Display Unit) The image data registered in "Image Registration" will display.

Image (CF) The CF-card image data registered in "Image Registration" will 
display.

Mark Displays registered marks in "Mark Registration".
Keypad The keypads registered in "Keypad Registration" will display.

• When you call a [Base Screen], call and place it in the center of the screen.
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5 Select an image and click [OK] to display the designated image.

• After drawing a [Call Screen] object, on the top left corner of the object, 
below the fixed pin, the jump icon becomes available. Click this icon to load 
the called screen. This feature is convenient for checking and editing screens.
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8.8 Editing a Picture on Another Screen

8.8.1 Placing Graphics Registered in a Package

You can place graphics registered in the package by dragging and dropping on the screen.

1 Displays registered shape lists. From the [View (V)] menu, select [Package (P)] or click .

• You can load and browse the packages registered on other computers or 
servers.

"8.13.2 Package List Setup Guide" (page 8-95)

Package

Drag and Drop

Objects registered in 
a package

Place it on the screen and edit it.
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2 In the [Package List] dialog box, select the package with the shape you want, and click 
[Open]. (For example, figure)

3 The [Package] dialog box is will appear. Select a picture and drag it to the drawing screen to 
place it.
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8.8.2 Registering Pictures in the Package

You can register a created object. You can also register a combination of multiple objects.

1 From the [View (V)] menu, select [Package (P)], or click .

2 In the [Package] dialog box, select the package name to register and click [Open]. (For 
example, figure) 

3 A dialog box of the selected [Package] will appear.

• You can save packages you create to other computers and servers.
"8.13.2 Package List Setup Guide" (page 8-95)

• To register pictures in a new package, click [OK].
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4 Select the figure to be registered and drag to the [Package] dialog box.

5 Package registration is complete.
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8.9 Creating a Screen from a Template

8.9.1 Setting up Grids

Introduction
You can display a grid with dots or lines on the drawing screen for reference when placing 
multiple objects.
The position of objects is defined by grid points, which makes it easier to adjust the object 
position.

Setup Procedure

Display a lined grid on the drawing screen and set the environment for placing an object 
along a line.

• Please refer to the Settings Guide for details.
"8.13.3 Preferences (Screen Edit Style) Setup Guide" (page 8-97)
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1 From the [View (V)] menu, select [References (O)].

2 The [Preferences] dialog box will appear. Select [Screen Edit Style].

3 Set up objects so they align with grid points when drawing or editing. In the [Grid] tab, select 
the [Snap to Grid] check box. In the [Grid Size (pixels)] list, select the grid spacing. (For 
example, 20 x 20).

• If you cannot find the desired [Grid Size], click [Edit List] to define a 
customized grid size.

"8.13.3 Preferences (Screen Edit Style) Setup Guide" (page 8-97)
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4 Defines the grid as either dots or lines. Select the [Show Grid] check box. Specify the display 
order and grid shape, and then click [OK]. 
(For example, [Order] Back, [Shape] Grid)

• Click [Change Color] to select the grid color from the color palette.
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8.9.2 Selecting a Screen from Templates

You can reduce the number of drawing processes by editing in a screen registered in the 
templates.

Placing a Screen Saved as a Template

1 From the [Screen (S)] menu, select [New Screen (N)].

2 The following [New Screen] dialog box will appear. Click [Select Template from List].

Select a template. 

Screen Image 3 

Template List 

Screen 
Image 1 

Screen
Image 2

Screen
Image 3

Screen
Image 4

Screen
Image 5

Screen
Image 6
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3 The registered templates display. Select a screen you want to use and click [OK].

4 The template is placed.
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Save as a Template
You can register created screens as templates and use them again. To make a screen into a 
template, from the [Screen (S)] menu, 
select [Register Template (T)].



Pasting an Image

GP-Pro EX Reference Manual 8-69

8.10 Pasting an Image

8.10.1 Target Image

Image data that can be displayed on the GP screen is as follows.

Image Pasting Method Description

Bitmap, 
JPEG, DPD, 
PNG File

Directly placing an 
image on the 
screen

Directly pastes BMP, JPEG, DPD, or PNG on the screen.

• In using the same image on the multiple screens, you can 
hold down the screen capacity by registering the original 
image in "Image".

• You can call the base screen with an image already placed 
onto another base screen.

"8.10.2 Pasting BMP/JPEG Procedure  Paste Images Directly 
on the Screen" (page 8-70)

Registering an 
image in "Image 
(Display)" and 
using Call Screen

Registers a BMP, JPEG, DPD, or PNG file as the "Image" 
and displays it on the base screen by using Call Screen.

• You can improve screen capacity by registering an image 
file in "Image" and using the same image on the multiple 
screens.

"8.10.2 Pasting BMP/JPEG Procedure  Registering and Using 
Images" (page 8-73)
"8.7 Using a Screen Multiple Times" (page 8-56)

Registering an 
image in "Image 
(CF)" and using 
Call Screen

Calls and displays the image data stored in the CF Card on 
the base screen.

"8.7 Using a Screen Multiple Times" (page 8-56)

Calling the base 
screen's image

Calls and displays the base screen's already created image 
data on the base screen.

"8.7 Using a Screen Multiple Times" (page 8-56)

Mark
Registered "Mark 
registration" 
images.

Calls and displays the dotted image data registered in "Mark" 
on the base screen.

"8.11 Drawing a Detailed Picture" (page 8-75)

Keypad Registered 
"Keypad" images.

Calls and displays the registered keypad on the base screen.
"8.7 Using a Screen Multiple Times" (page 8-56)

• You can call one keypad from a [Call Screen] part on a 
Base Screen.
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8.10.2 Pasting BMP/JPEG Procedure

Paste Images Directly on the Screen

1 From the [Draw (D)] menu, select [Image Placement (I)] or click .

• You can select a particular color only from the used colors and change that 
color to the specified hue. For the setting method, refer to the following.

"20.7.1 [Animation Settings] Settings Guide  Hue Animation" (page 20-32)

Converts image data and 
places it on the screen. 

BMP, JPEG, etc. 
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2 Click the screen drawing area to place the image part. Double-click the object to open its 
dialog box and define the [Files of type] and [File name] of the image to paste.

3 Adjust the image quality and number of colors, and click [Open].

• You can also copy bitmaps on the PC. Click the GP-Pro EX drawing area, 
and then from the [Edit] menu, select [Paste]. After selecting the [Paste] 
command, the dialog box above displays.

• Select [Transparent] check box to enable the [Settings] button. Click the 
button, and in the [Transparent Color Settings] dialog box, use a dropper to 
select the color on the image to make transparent. This feature is useful for 
making the background color transparent on pasted images.
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4 The following [Image Registration] dialog box will appear. Set the size and blink rate for the 
image to paste.

5 Click [OK] and the designated image will be placed.

• When [Original Size] is selected, an image is placed with the same size as the 
original image. You cannot change the image size after placing it.

• When [Fix Aspect Ratio] is selected, an image is placed with the original 
image horizontal to vertical ratio fixed.
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Registering and Using Images
Using Image Registration and using its images, you can reduce the volume of image data.

1 From the [Common Settings (R)] menu, select [Image Registration (I)], or click  to 
display the following dialog box.

2 Click [Add]. The [Add Image] dialog box appears. Select a graphic and click [Open].
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3 If required, add comments to images, set the brightness or colors, and then click [Close]. 
Image registration is complete.

4 The registered image can be loaded to the screen. The following describes the steps.
"8.7 Using a Screen Multiple Times" (page 8-56)



Drawing a Detailed Picture

GP-Pro EX Reference Manual 8-75

8.11 Drawing a Detailed Picture

8.11.1 Drawing a Valve

Introduction
You can call and display image data created in a Mark to the base screen. In [Mark 
Registration], you can use dots to draw your own symbols or pictures.

Setup Procedure

To draw a valve with dots:

• Please refer to the Settings Guide for details.
"8.13.4 Common Mark Registration Settings Guide" (page 8-102)
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1 From the [Common Settings (R)] menu, click [Mark Registration (M)]. Select [New] and 
enter the [Number] and [Comment] and click [New]. (For example, [Number]=1, 
[Comment]=Mark) 

2 Create an outline of the valve body with a rectangle. From the [Draw (D)] menu, select 
[Filled Rectangle]. Place after dragging to adjust the size and location of the rectangle.

• From the [Edit] menu, click [Undo (U)] to undo the command.
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3 Create a valve opening with an ellipse. From the [Draw (D)] menu, select [Filled Circle/
Ellipse (C)] and place the object after adjusting the size and location of the ellipse.

4 Create an outline of the valve opening using [Color Inversion]. From the [Edit] menu, select 
[Color Inversion (Y)] to mirror the dot on the campus. In this state, from the [Draw (D)] 
menu, select [Filled Circle/Ellipse (C)] to place after adjusting the size and location of the 
ellipse. After placement, click [Color Inversion (Y)] again to return to the campus state.

5 Create the handle part with an ellipse and rectangle. From the [Draw] menu, select [Circle/
Ellipse (C)] or [Filled Rectangle (T)]. 
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Click [Filled Rectangle (T)] and place the object after adjusting the size and location of the 
oval or rectangle.

6 Fine tune each part using dots. From the [Draw (D)] menu, select [Dot (D)]. To draw, you can 
click to turn ON (white) and right-click to turn OFF (black).
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7 Click the [Base 1] tab and open a base screen to place the mark. From the [Draw (D)] menu, 
click [Call Screen (O)].

8 Click the drawing screen and the dotted border is placed and the [Call Screen] dialog box will 
appear.

• From the [Screen (S)] menu, select [New Screen (N)] to create a new base 
screen.
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9 Select [Mark Registration] from [Call Target] and select the mark number registered in 
[Number]. (For example, 1)

10 Select an image and click [OK] to display the designated image.

• You can designate the display color of the created mark.
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8.11.2 Displaying a Character External to the Character Code

Draw an external character with dots in Mark. You can display registered external characters 
on the screen.
You can register external characters only when selecting the ASCII standard font (bitmap 
font) and the font size of 8 x 16 dots or larger.

Setup Procedure
You can display the created character on the screen by replacing a character in the frame in 
the character code table with it. The following is the procedure for replacing the character "ë" 
(89h) in the character code table (Code Page 850) with the character "III", which was created 
with dots, and displaying the character "III" on the GP screen.

Character Code Table 
The following is the character code table of Code Page 850, the character code used on the 
GP.

GPMark

Corresponds to 
89h "ë"
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1 From the [Common Settings (R)] menu, click [Mark Registration (M)]. Select [New], and 
enter the mark number "8010" in the [Number] which corresponds to the character ë (89h) in 
the character code table, and click [New]

"  Input Code Table" (page 8-85)

2 Draw a special character. Create "III" to display on the screen.
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3 Click the [Base 1] tab, select the [Draw (D)] menu, and then select [Text (S)].

4 Place the text on the screen, and double-click it to open the [Text] dialog box.
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5 In the text input area, while holding down the [Alt] key, type the [Input Code] "0235", which 
corresponds to text code (89h). Upon releasing the [Alt] key, ë is input. Click [OK].

"  Input Code Table" (page 8-85)

• The character placed on the drawing screen displays as "ë". However, on the 
screen display transferred to the GP, "III" will display.
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How to Display Characters Whose Character Code is Not Listed
The marks drawn for the mark numbers from 8001 to 8128 are treated as the characters of the 
character codes from 80h to FFh. For example, 8001 corresponds to 80h, and 8002 to 81h.
If you create marks for these mark numbers, they will be registered as external characters.
By inputting the input code corresponding to a mark number on the base screen, the character 
displayed on the base screen displays as a registered external character on the GP.

Input Code Table

8001
8002
8003
8004
8005
8006
8007
8008
8009
8010
8011
8012
8013
8014
8015
8016
8017
8018
8019
8020
8021
8022
8023
8024
8025
8026
8027
8028
8029
8030
8031
8032
8033
8034
8035
8036
8037
8038
8039
8040
8041
8042
8043
8044
8045
8046
8047
8048

80h
81h
82h
83h
84h
85h
86h
87h
88h
89h
8Ah
8Bh
8Ch
8Dh
8Eh
8Fh
90h
91h
92h
93h
94h
95h
96h
97h
98h
99h
9Ah
9Bh
9Ch
9Dh
9Eh
9Fh
A0h
A1h
A2h
A3h
A4h
A5h
A6h
A7h
A8h
A9h
AAh
ABh
ACh
ADh
AEh
AFh

0199
0252
0233
0226
0228
0224
0229
0231
0234
0235
0232
0239
0238
0236
0196
0197
0201
0230
0198
0244
0246
0242
0251
0249
0255
0214
0220
0248
0163
0216
0128
0129
0225
0237
0243
0250
0241
0209
0170
0186
0191
0174
0172
0189
0188
0161
0171
0187

8049
8050
8051
8052
8053
8054
8055
8056
8057
8058
8059
8060
8061
8062
8063
8064
8065
8066
8067
8068
8069
8070
8071
8072
8073
8074
8075
8076
8077
8078
8079
8080
8081
8082
8083
8084
8085
8086
8087
8088
8089
8090
8091
8092
8093
8094
8095
8096

B0h
B1h
B2h
B3h
B4h
B5h
B6h
B7h
B8h
B9h
BAh
BBh
BCh
BDh
BEh
BFh
C0h
C1h
C2h
C3h
C4h
C5h
C6h
C7h
C8h
C9h
CAh
CBh
CCh
CDh
CEh
CFh
D0h
D1h
D2h
D3h
D4h
D5h
D6h
D7h
D8h
D9h
DAh
DBh
DCh
DDh
DEh
DFh

0130
0131
0132
0133
0134
0193
0194
0192
0169
0135
0136
0137
0138
0162
0165
0139
0140
0141
0142
0143
0144
0145
0227
0195
0146
0147
0148
0149
0150
0151
0152
0164
0240
0208
0202
0203
0200
0153
0205
0206
0207
0154
0155
0156
0157
0166
0204
0158

8097
8098
8099
8100
8101
8102
8103
8104
8105
8106
8107
8108
8109
8110
8111
8112
8113
8114
8115
8116
8117
8118
8119
8120
8121
8122
8123
8124
8125
8126
8127
8128

E0h
E1h
E2h
E3h
E4h
E5h
E6h
E7h
E8h
E9h
EAh
EBh
ECh
EDh
EEh
EFh
F0h
F1h
F2h
F3h
F4h
F5h
F6h
F7h
F8h
F9h
FAh
FBh
FCh
FDh
FEh
FFh

0211
0223
0212
0210
0245
0213
0181
0254
0222
0218
0219
0217
0253
0221
0175
0180
0173
0177
0159
0190
0182
0167
0215
0184
0176
0168
0183
0185
0179
0178
0247
0160

Mark 
Number

Mark 
Number

Text Code
Code Page 850

Input Code
(Alt + Code)

Text Code
Code Page 850

Input Code
(Alt + Code)

Mark 
Number

Text Code
Code Page 850

Input Code
(Alt + Code)
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8.12 Making an Animated Screen By Controlling Colors and 
Display of Drawings Animation

8.12.1 Types of Animation That can be Set

Show/Hide of the Drawing
The drawing can be hidden once and displayed again when needed. It can be used also as a 
security feature such as keeping it normally hidden so that only a particular person can 
operate it.

For example:

Change the Position of the Drawing
By moving the drawing, changes in actual situations can be displayed on the screen.

For example:

• For more information about the animation feature, please refer to the 
following.

"Chapter 20 Animating Screen Objects", page 20-1

Turn on the 
specified Bit...

A switch that was 
hidden appears.

A value is written 
to the specified 
address...

The drawing moves 
within the specified 
range.
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Rotating Drawings
The drawing can be rotated to display rotating actions of equipment such as fans and motors.

For example:

Change the Color of the Drawing
The color of the drawing can be changed at an arbitrary timing. Change the color as the value 
exceeds a certain value, and when you want to distinguish among error messages.

For example:

A value is written 
to the specified 
address... The drawing 

rotates.

100 200

The value exceeds 
a certain value... The color 

changes.
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8.12.2 Setup Procedure

1 Select a drawing for which you want to set the animation, and click [Animation (N)] in the 
[Edit (E)] menu.

• Please refer to the Animation Settings Guide for details.
"20.7 Settings Guide" (page 20-23)
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• The animation settings screen can also be displayed as follows.
•Select a drawing, and click  in [Properties] - [Animation].

•In the [Screen Data List], double-click the [Animation] column of the part 
you want to edit.
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2 The [Animation Settings] dialog box will appear. Select the type of animation from the list on 
the left of the screen. Set the animation on the right of the screen.

• The type of animation that can be set varies depending on the selected parts 
and drawings.

"20.1.2 Supported Objects" (page 20-4)



Settings Guide

GP-Pro EX Reference Manual 8-91

8.13 Settings Guide

8.13.1 Text Settings Guide

Setting Description

Direct Text Input text into the Input Text window and place it directly as fixed text.

Font Type

Select from among [Standard Font], [Stroke Font], and [Image Font].
• Standard Font

You can select the bitmap font from [ASCII], [Japanese], [Chinese 
(Traditional)], [Chinese (Simplified)] or [Korean].

• The standard font will become bitmap font. The display speed is faster 
than with other fonts, but characters may have jagged outlines or distort 
if enlarged/reduced too much.

• The Japanese and ASCII standard fonts are transferred to the GP. To 
use the Chinese (Simplified), Korean, or Chinese (Traditional) standard 
font, you must add the font in [System Settings/Font].

"6.2 Defining Stroke Font and Standard Font" (page 6-3)

Continued
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Font Type

• Stroke Font
You can select the vector font from [ASCII], [Japanese], [Chinese 
(Traditional)], [Chinese (Simplified)], [Korean], [Cyrillic], or [Thai].

• The stroke font will become vector font. Characters are displayed with 
smooth outlines when enlarged, but the display speed is slower than with 
the standard font.

• The ASCII stroke font will be transferred to the GP. To use the Japanese, 
Chinese (Simplified), Korean, Chinese (Traditional), Cyrillic or Thai 
stroke font, you must add the font in [System Settings/Font].

"6.2 Defining Stroke Font and Standard Font" (page 6-3)

• Image Font
Displays a Windows font as bitmap data.

"6.3 Image Font" (page 6-14)

Text Size

Select the text size. Each font type has a different size range.
Standard Font  You can select the font size from either [8 x 8 pixels] to [64 

x 128 pixels] in increments of 8 pixel units, or a fixed font 
size from [6 x 10 pixels], [8 x 13 pixels], or [13 x 23 pixels]. 
When using fixed sizes, you can display only single-byte 
alphanumeric characters.

Stroke Font: 6 to 127
When the [Automatically Adjust Text Size] check box is selected, set the 
font's [Maximum Size] and [Minimum Size].

• To use alphanumeric fonts, select [ASCII] as your Display Language.

Display 
Language

Choose a text display language from [ASCII], [Japanese], [Chinese 
(Traditional)], [Chinese (Simplified)], [Korean], [Cyrillic], or [Thai].

Text Attributes

When [Font Type] is [Standard Font] or [Stroke Font], select from the 
following text attributes.
Standard Font: Choose from [Standard], [Bold], [Shadow]

(When using a fixed font size [6 x 10], select from [Standard] or 
[Shadow].)

Stroke Font: Choose from [Standard], [Bold], [Outline]
Direction Select from [Portrait] or [Landscape].

Centering When selecting "Vertical", align the center of text with single-byte and 
double-byte characters.

Input Text Field If [Direct Text] is selected, input the character string.
Continued

Setting Description
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Text Table Use text from a previously saved Text Table.
"17.4 Changing a Text's Language (Multilanguage)" (page 17-15)

Font Type

Select either [Standard Font] or [Stroke Font].
• Standard Font

You can select the bitmap font from [ASCII], [Japanese], [Chinese 
(Traditional)], [Chinese (Simplified)] or [Korean].

• The standard font will become bitmap font. The display speed is faster 
than with other fonts, but characters may have jagged outlines or distort 
if enlarged/reduced too much.

• The Japanese and ASCII standard fonts are transferred to the GP. To 
use the Chinese (Simplified), Korean, or Chinese (Traditional) standard 
font, you must add the font in [System Settings/Font].

"6.2 Defining Stroke Font and Standard Font" (page 6-3)
• Stroke Font

You can select the vector font from [ASCII], [Japanese], [Chinese 
(Traditional)], [Chinese (Simplified)], [Korean], [Cyrillic], or [Thai].

• The stroke font will become vector font. Characters are displayed with 
smooth outlines when enlarged, but the display speed is slower than with 
the standard font.

• The ASCII stroke font will be transferred to the GP. To use the Japanese, 
Chinese (Simplified), Korean, Chinese (Traditional), Cyrillic or Thai 
stroke font, you must add the font in [System Settings/Font].

"6.2 Defining Stroke Font and Standard Font" (page 6-3)

Text Size

Select the text size. Each font type has a different size range.
Standard Font  You can select the font size from either [8 x 8 pixels] to [64 

x 128 pixels] in increments of 8 pixel units, or a fixed font 
size from [6 x 10 pixels], [8 x 13 pixels], or [13 x 23 pixels]. 
When using fixed sizes, you can display only single-byte 
alphanumeric characters.

Stroke Font: 6 to 127
When the [Automatically Adjust Text Size] check box is selected, set the 
font's [Maximum Size] and [Minimum Size].

• To use alphanumeric fonts, in the [Text Table] editor click [Change 
Language]. In the [Language Change] dialog box, set a table in the 
[Language] column to [English].

Continued

Setting Description
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Automatically 
Adjust Text 
Size

With the range of maximum and minimum text sizes that have been set, the 
font size adjusts automatically to fit the text.

• The range cannot be set when Standard Font is selected.
Maximum 
size 6-127

Minimum 
size 6-127

Text Attributes

When [Font Type] is [Standard Font] or [Stroke Font], select from the 
following text attributes.
Standard Font: Choose from [Standard], [Bold], [Shadow]

(When using a fixed font size [6 x 10], select from [Standard] or 
[Shadow].)

Stroke Font: Choose from [Standard], [Bold], [Outline]
Direction Select from [Portrait] or [Landscape].

Centering When selecting "Vertical", align the center of text with single-byte and 
double-byte characters.

Select text Select text from the Text Table.
Text Color Set the display color for the text.
Background Color Set the background color for the text.

Shadow Color
If the [Font Type] menu - [Standard Font] command and the [Text 
Attribute] menu - [Shadow] command are selected, set the color for the 
text shadow.

Display Language Choose a text display language from [ASCII], [Japanese], [Chinese 
(Traditional)], [Chinese (Simplified)], [Korean], [Cyrillic], or [Thai].

Line Spacing
Set a value from 0 to 255. This is only applicable when in the [Text] field 
you add multiple lines of text. 
This option cannot be used when the [Font Type] is set to [Image Font].

Align Specifies whether text is fixed to the center of parts.

• Select the text placed on the screen and press [F2] key, and you can directly 
edit the text.

Setting Description
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8.13.2 Package List Setup Guide

Displays the Package List registered in GP-Pro EX. You can register user-created parts, 
drawings, keypads, and so on. One [Package] can store a combination of 200 drawings, parts, 
and keypads. If a drawing or part is registered in multiple groups, it counts as one in the 
package count.

Setting Description

Reference External 
Package 

Sets up references of external packages.

• If enabled, lists registered packages and registered reference folder 
packages.

• If the reference folder is not found, an error message appears and the list 
displays registered packages only.

External Package 
Reference Folder

Displays the location of the reference folder.
• Change Reference

Displays a dialog box for changing reference to external packages.
Input the location of the folder directly or click [Browse] and select the 
folder from the [Browse folder] dialog box.

Package List

Displays a Package list.
• Name

Displays the names of all the packages registered in a project file.
• Type

Displays types of packages from among the following three types.
System : Registered package
User : Package created by users
External : External package

• Creation Date
Displays the dates when the packages were registered.

Continued
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New

Displays the [New Package] dialog box. Set a name of a new part, drawing, 
keypad, etc. to register in the package within 64 characters.

Open

Displays the [Package] window. You can register parts, drawings, and 
keypads by dragging them in from the drawing screen. You can drag and 
drop parts, drawings, and keypads registered in the [Package] onto the 
drawing screen.

• You can also display the [Package] window from the [View (V)] menu. 
Point to [Work Space (W)] and then click [Package (K)].

Delete Deletes the parts, drawings, keypads, etc. previously registered in 
[Package].

Rename

Displays the [Rename Package] dialog box. Renames the parts, drawings, 
keypads, etc. previously registered in [Package]. Set a new name within 64 
characters.

Export

Outputs packages created by users to the [External Package Reference 
Folder].

Import Imports as user packages external packages selected from the list.
Close Closes the [Package List] dialog box.

Setting Description
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8.13.3 Preferences (Screen Edit Style) Setup Guide

On the [View (V)] menu, click [Preferences (O)]. The following [Preferences] dialog box 
will appear. Select [Screen Edit Style] in the left window.

Action

Setting Description

Show Guide on 
Move or Resize

This function is valid when aligning an object with a previously placed object.
Guidelines are displayed at the designated points (the left edge and upper 
edge).

Label Resizing 
Process

Set whether the size of the label (text) will also be changed when the size of 
the part is changed.

Drawing Process 
for Parts/
Drawings

Specify whether drawings and parts can be placed continuously when they are 
created.
If you cancel continuous placement, right-click on the unused screen area, or 
select the menu and icons of other features.

Clear Defaults Right-click Draw/Parts, and from the menu, reset the default attributes of 
Draw/Parts set in [Set as Defaults of Parts].
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Grid

Setting Description

Snap to Grid
The cursor position is determined from the grid size, you don't have to fine 
tune the position.

"8.9 Creating a Screen from a Template" (page 8-63)

Grid Size (pixels)

Select the grid size from a list.
• Edit List

If the list does not have the desired size, display the [Edit Grid Size] dialog 
box and specify the width and height.
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Show Grid 

Designate whether or not to show a grid.
• Order

Select the display order from [Back] or [Front].
• Shape

Select the shape from [Grid] or [Dot].
• Color specification

Display set colors. To change, click [Change Color] and select the color that 
you want to display from the color palette.

Setting Description



Settings Guide

GP-Pro EX Reference Manual 8-100

Display

Setting Description

Show Fixed Pin of 
Parts and Called 
Screens

Specify whether a pin mark and jump icon should be displayed when 
selecting objects.

• If you click the pin mark, the Move and Edit Object functions will be 
locked and the pin mark will be red.

• Click the jump icon to open the screen to be called.

Show Ruler

Shows rulers at the top and the left side of the screen.

Show Touch Area

Specify whether the Touch Input Valid Area is shown or not.

• Place each object so that the touch areas do not overlap each other.
Show Window Part 
Screens Specify whether the Window Parts Screen is shown or not.

Show Package 
Images

Place the cursor on the figure in the [Package] window screen to display 
figure images.

Continued
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Display Navigator

Display the navigator. Display/Hide the placed parts.
Move the cursor close to the [Display Navigator Icon] on the top right of 
the drawing screen to display the navigator.

• Click the [Display Navigator] icon  to hide the parts in the order they 
are placed.  Click the icon to show the parts in order.

• Parts that are hidden by the [Display Navigator] have rows of parts 
grayed out in the [Screen Data List] window. Select the gray parts in the 
list to display it.

• Select [Display Navigator] -  and drag it to the left or right to display/
hide the part.

Character 
Information

Designate whether or not to show character information of the placed parts 
on the parts, and the display format.

Show Parts ID Designate whether or not to show the ID number of the placed part.
Show Address Designate whether or not to show the address set for the part.
Display Faded 
in Background

Designate whether to display the background as semi-transparent when 
showing the part ID and addresses.

Text Size Select the text size for the part ID and addresses from [Standard] or 
[Reduced].

Setting Description
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8.13.4 Common Mark Registration Settings Guide

New

Open

Setting Description
New Creates a new [Mark Registration] screen.
Open Opens a previously created [Mark Registration] screen.

Number Set the [Mark Registration] screen Number to any value between 1 and 
8999.

Comment Enter a comment of up to 30 characters for the [Mark Registration] screen.

Setting Description
New Creates a new [Mark Registration] screen.
Open Opens a previously created [Mark Registration] screen.
List of marks Displays the list of the [Mark Registration] screens in the project file.

Continued



Settings Guide

GP-Pro EX Reference Manual 8-103

Mark Registration

Number Displays the number of each [Mark Registration] screen.
Comment Displays the comment for each [Mark Registration] screen.

Mark preview Provides a preview display of the marks in the [Mark Registration] screen 
selected in the mark list.

Number Displays the number of the [Mark Registration] screen selected in the 
mark list.

Comment Displays the comment for the [Mark Registration] screen selected in the 
mark list.

Setting Description
Preview area Provides a preview display of the mark's on-screen display size.

Drawing area

Used to draw marks using the drawing operations below, which can be 
selected from the menu and toolbar.
• [Dot]
• [Line]
• [Rectangle]
• [Circle/Oval]
• [Filled Rectangle]
• [Filled Circle/Ellipse]
• [Fill]
• [Text]
• [Draw Size]
The following items are displayed in the drawing area:
• Origin
• 48 x 48 dot grid
• Quadrant (8 x 8 dot area) borders
• Dot ON, Dot OFF (Black), Dot OFF (Transparent)

Setting Description



Restrictions

GP-Pro EX Reference Manual 8-104

8.14 Restrictions

8.14.1 Restrictions for Drawing (Text)

• When text is enlarged or rotated, the thickness of some letters may change.
• For characters with a character code (0x80 to 0xFF), the characters' shape will change due 

to differences in font between GP-Pro EX and GP.

8.14.2 Restrictions for Pasting BMP/JPEG

• If you set the background color to the screen used for a call screen, the objects placed on 
the screen are not displayed on the GP.

• For a color data image screen, the data capacity is large, but the display speed on the GP is 
fast. For a monochrome data image screen, the display speed on the GP is somewhat slow, 
but the data capacity can be saved. Convert screens depending on the purpose.

• If an image screen is placed beyond the drawing area, the part that is outside the area is 
not displayed on the GP.

• Nesting (calling hierarchy) up to 10-layer (11-fold) is available. However, if the remain-
ing memory in the PC decreases in operation, the display on the screen may be omitted. 
When transferred, the nested objects are normally displayed on the GP.
For example, double-layer (threefold) nesting.

Drawing 
Area

B100 

Call screen B100 Call screen B10 

B10 B1 
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8.14.3 Package Registration Restrictions

• Packages are registered and saved when you close the GP-Pro EX project.
• Up to 200 objects can be registered in one package. To register more than 200 objects, 

create a new package and register them in a new category.

8.14.4 Restrictions on Marks

• Acknowledge the registered external character after the screen data transmission on the 
display unit. The text corresponding to the input text code displays on GP-Pro EX.

• External characters can be registered only when the English standard font with a font size 
of 8 x 16 pixel or larger is selected. 8 x 8 pixel is not supported.

• To create an external character, draw it with single-byte characters (within 8 x 16 dot) 
with reference to the origin of the mark creating area (0,0).

• External characters cannot be rotated.
• When you print text in Alarm, external characters are not outputted. The results, depend-

ing on printer types, are as follows:
For NEC PR201, EPSON ESC/P, HP Laser Jet, and Text ASCII:
Direct code output of the text codes.
For EPSON PM/Stylus:
Image output of Code Page 850 characters

• If you were using the Character code (0x80 to 0xFF) of the Western standard fonts in a 
CSV file while registering external marks, and you want to display the marks in the Spe-
cial Data Display [CSV Display] and [CSV Data Transmission] on GP, they will be con-
verted to the external characters that were registered in the mark screen.

8.14.5 Restrictions for Screen Display

When you reduce the screen edit area with the zoom function, some drawings may not 
display correctly, depending on the magnification.
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